
 RealAudio Player Help Contents 
For information on using the RealAudio Player for Windows, choose one of the topics below.    

Quick Start 
File Menu 
View Menu 
Troubleshooting 

For the latest information on RealAudio products and Web sites, visit the Progressive Networks home 
page at: 

http://www.RealAudio.com

The latest support and technical information is available at:

http://www.RealAudio.com/help.html



 Quick Start 
The RealAudio Player provides real-time audio on demand over the Internet.    For the latest information 
on RealAudio products and Web sites, visit the Progressive Networks home page at:
 

http://www.RealAudio.com.

Playing Audio
After installing the RealAudio Player, click any RealAudio link on a World Wide Web page and the player
will start automatically.    (You do not need to first load the RealAudio Player, it will be loaded by your 
Web browser.)    For a frequently updated listing of World Wide Web sites containing RealAudio links, 
see

http://www.realaudio.com/othersites/categories/complete.html.

Supported Audio Formats
The RealAudio Player plays RealAudio files, which usually end with an .RA or .RAM extension.    It does 
not play .AU or .WAV files.    To convert an .AU or .WAV file to a RealAudio file, use the RealAudio 
Encoder, available from the Progressive Networks Web site.

Volume Control
Volume control is available when the Info & Volume option on the View menu is checked.    To adjust the 
volume using the player, move the slider.    You can also control the volume by adjusting the master 
volume in the mixer application supplied with your sound card or with Windows.

If you do not hear any sound or the volume is very low, check the volume control on your speakers and 
your mixer settings for Wave and Master volume.
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 File Menu 
Commands on the File menu allow you to play RealAudio files directly from the Player without using 
your World Wide Web browser.

Open Location
Plays a file on a RealAudio Server through the Internet without using a World Wide Web browser. Enter 
a URL to a RealAudio file in the dialog as follows:

pnm://Servername/complete-path-to-file

where:

pnm is the RealAudio protocol name
ServerName is the address of the RealAudio Server
complete-path-to-file is the complete path to the file on the RealAudio Server

This feature is useful to those who maintain RealAudio sites and want to test their servers. Using the 
Player in this fashion is not recommended: you have to remember the exact file and server name.

Note: Open Location does not accept other kinds of URLs such as http, ftp, or gopher.    Use your Web 
browser instead.

Open File
Plays a local RealAudio file from your hard disk.    Select an .RA or .RAM file in the Open File dialog.
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 View Menu 
Commands on the View menu allow you to modify the appearance of the Player and to set Options.

Info and Volume
Displays or hides the volume control and the title, author, and copyright information for the clip.    To 
adjust the volume using the player, move the slider.    You can also control the volume by adjusting the 
master volume in the mixer application supplied with your sound card or with Windows.

If you do not hear any sound or the volume is very low, check the volume control on your speakers and 
your mixer settings for Wave and Master volume.

Status Bar
Displays or hides the Status Bar, which shows the current status of the Player, the length and position of
the RealAudio file, and help text for the menu commands.    Check or un-check this menu item to toggle 
display of the status bar.

Options
Displays the Options Dialog for configuring the Player.

Statistics
Displays transmission quality information in the modeless Connection Statistics dialog.

Always on Top
Selecting this option makes the RealAudio Player remain on top of all other windows, even when 
another window is active.    Always on Top is convenient for keeping the Player visible while you interact 
with your Web browser.
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 View Menu - Options Dialog 
Settings in the Options dialog allow you to configure the RealAudio Player for your system.

Loss Correction
When Loss Correction is checked, the RealAudio Player compensates for packets lost in transmission 
between the RealAudio Server and your Player.    You may hear a momentary warble in the audio stream
if packets are missing.      When Loss Correction is unchecked, the lost packets are dropped, causing a 
skip.

Send Statistics
Controls whether the RealAudio Player sends connection quality statistics to the RealAudio Server after 
playing a clip.    To help connection providers assure transmission quality, the RealAudio Player sends 
some transmission statistics to the RealAudio Server.    This information includes the same information 
you see in the Connection Statistics dialog:

the number of packets received
the number of packets lost in transmission
the number of packets arriving late

If you do not want your Player to send statistics back to the Server, clear the Send Statistics option.

The RealAudio Player does not access nor send to the Server any information about your identity such 
as your user name, e-mail address, or passwords.

Connection Timeout
Specifies the maximum number of seconds the RealAudio Player waits for a Server to respond.    If the 
Player does not connect to the server within the time specified, a Retry/Cancel box is displayed.    The 
default value is 30 seconds.    A value of 0 means never time out.

Advanced Options
Advanced Options override Player defaults for sound card compatibility and allows you to set the data 
loss level at which a warning is displayed.

Use 8-bit Only
Use this option only if there is evidence of compatibility problems with your sound card.    The 
Player normally delivers 16-bit audio to the sound card.    If the sound card only supports 8-bit 
audio, the Player delivers 8-bit audio.    If the Player is unable to recognize that your sound card 
does not support 16-bit audio, you may hear only random or garbled sound when playing clips.   
Check this option to override the 16-bit default and play 8-bit sound.

Use 11-kilohertz Only
Use this option only if there is evidence of compatibility problems with your sound card.    The 
Player normally delivers 8-kilohertz audio to the sound card.    If your sound card does not 
support the 8-kilohertz sample rate, the audio may sound high-pitched or too fast.    Check this 
option to instruct the Player to convert audio to 11 kilohertz before delivering it to the sound 
card.    This option requires extra processor overhead to play sound.



Acceptable Loss
The Player will display a warning message when the Internet connection is not providing 
acceptable quality.    The default value is 10% loss in any 30-second period.    You can increase 
this percentage to allow greater loss without displaying a warning or decrease the value if you 
wish to be notified at lower levels of loss.    See also: Connection Statistics.

Use Proxy, Configure Proxy
This option is not currently available.    Future implementation will allow the RealAudio Player to 
receive audio through firewalls.



 View Menu - Connection Statistics Dialog 
This dialog displays statistics about the connection quality between your Player and the Internet site 
serving the clip that is currently playing.    Missing data packets create a momentary warble in the audio 
or, if Loss Correction is turned off, a skip.

If you experience low sound quality due to lost data packets, temporary network transmission difficulties 
or extremely heavy loads on the server site may be the cause.    You may wish to try again later or visit 
another site.

If you consistently experience high rates of loss and you use a dial-up Internet connection, your modem 
may be connecting at less than 14.4kbps, or your Internet Service Provider may not be providing 
sufficient bandwidth to service your connection.    Contact your system administrator.

The Player will display a Loss Warning Dialog if the connection quality falls below an acceptable level 
during any 30-second period.



 Loss Warning Dialog 
The RealAudio Player displays the Loss Warning dialog to inform you when the Internet connection 
quality falls below an acceptable level.

Use the Connection Statistics dialog to view detailed information about transmission quality.    You can 
set the percentage of loss at which the Loss Warning is displayed in the Advanced section of the 
Options dialog.



 Troubleshooting 
If you experience problems with the RealAudio Player, please consult the latest troubleshooting 
information and FAQ (Frequently Asked Questions) available on our Web site at:

http://www.RealAudio.com/help.html.

This help contains information on the following troubleshooting topics:

No sound or garbled audio: sound card compatibility
Web browser prompts for Save To Disk instead of launching PlayerAudio will not play: Firewalls
Audio will not play: TIA (The Internet Adapter )
Configuring a Web browser for RealAudio
MIME Types

Updates available at the time of release can be found in the readme.txt file in the Player installation 
directory.

No sound or garbled audio: sound card compatibility
The RealAudio Player has been extensively tested with a wide variety of sound cards under all versions 
of Windows.    However, if the sample Thank You and Welcome clips played by the installation program 
are garbled or do not play, there may be a compatibility difficulty with your sound card.    Follow these 
steps to resolve the problem:

1. Contact the card manufacturer to obtain the latest drivers.    Updated drivers solve most 
compatibility problems.

2. Try selecting the Use 8-bit only and Use 11-kilohertz options in the Advanced section of the 
Options dialog.    To test playback, use the Open File dialog and select start.ram from the Player 
installation directory.

3. If the above steps do not solve the problem, visit

 http://www.RealAudio.com/help.html 

and submit a problem report form.

Web browser prompts for Save To Disk instead of launching Player
If your Web browser displays a prompt with options such as Save to Disk instead of launching the 
RealAudio Player, the Player has probably not been configured correctly.    If your system or browser 
configuration has changed since running the setup program, the easiest solution is to run the setup 
again.    If the problem persists, consult the section on Configuring a Web browser for RealAudio.

If you see a Save to Disk prompt only on a particular site or clip, the site's server may not be configured 
correctly.    You can verify that your Player is configured correctly by playing clips on the Progressive 
Networks Web site (http://www.RealAudio.com).    In this case, contact the site administrator and do 
not adjust your configuration.



Audio will not play: Firewalls
RealAudio uses port 7070 for TCP and ports 6970 through 7170 inclusive for UDP transmission. If you 
are accessing RealAudio through a firewall, your firewall administrator will need to authorize these ports.
You can point your administrator to our firewall page at
 

http://www.RealAudio.com/firewall.html

for details.

Audio will not play: TIA (The Internet Adapter)
At release time, The Internet Adapter (TIA) was not compatible with the RealAudio Player.    TIA is a 
program that provides pseudo-SLIP access to the Internet.    If your dial-up connection does not allow 
you to play RealAudio, your Internet provider may be using TIA.    Symptoms of a TIA connection include
a Player that halts after the buffering message when attempting to play a clip.

For the latest information on TIA compatibility, consult the RealAudio FAQ (Frequently Asked Questions) 
at:
 

http://www.RealAudio.com/help.html

Configuring a Web browser for RealAudio
The RealAudio Player setup program automatically recognizes and configures all popular Web browsers
for Windows.    If your browser is not recognized by the setup program, or is newer than this release of 
the Player, you may need to configure the browser manually.

First, check for information related to your browser in the RealAudio FAQ (Frequently Asked Questions) 
at 

http://www.RealAudio.com/help.html
 

If information is not available, consult your browser documentation on configuring Helper Applications or 
External Viewers.    Add the RealAudio Player as an application with the following information:

MIME type: audio/x-pn-realaudio
Extensions: .ra, .ram
Application: raplayer.exe (The default installation directory is c:\raplayer.)

MIME Types
World Wide Web browsers refer to MIME types to determine what action should be taken on a particular 
link.    Most of the time, a consistent set of file extensions are used for each MIME type.    In your 
browser, you determine what actions should be taken to display each type.    You can change these 
actions by changing the values under Helper Applications or External Viewers.    For RealAudio files, the 
MIME type is audio/x-pn-realaudio.    See Configuring a Web Browser for RealAudio for more 
information.
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